Encore looks very much
like any other Adobe
software. Once you get
the logic, it's pretty easy
to learn. Knowing the DVD
format helps, of course.
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Although the demand for DVDs and Blu-rays is rapidly diminishing, some customers still
want a shiny disc to put in the drawer. So we need to make some. If you're creating a DVD,
I recommend that you nest your HD sequences into an SD sequence, right click the nested

sequence, and choose Set to Frame Size. This will give you a good preview of how the
resulting video will look.

If you're going out to Blu-ray, you can follow pretty much the same steps as below, but
choose MPEG2 Blu-ray instead of MPEG2-DVD.

The latest version of Encore is CS6, and you have access to it if you're subscribing to

Creative Cloud. This document describes how to download it: http://helpx.adobe.com/
encore/kb/encore-cs6-installed-cc.html

Before you start building your DVD, make sure you gather all the assets into one folder, so
it's easy to find everything later.

Collect all the assets before
you start building your DVD
Del  Visning - @ or Blu-ray project.
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Chapter markers from By default, Chapter Markers in Premiere are red. All of these have
Premiere will carry over to names, and will carry over as Chapter Markers in Encore.

Encore if they are given a
name.

Scrub your timeline, and wherever you want a chapter marker on your DVD, hit M to create
a marker. Turn every marker into chapter marker and give them a name. This is important! If
you don't give them names, they will not import to Encore.

You know you have a chapter marker when it's got a red icon and the name appears when

you hover your cursor over it.

Export to DVD Formats

In the Export dialog choose MPEG2-DVD, and choose Widescreen 16:9. If you want to get
rid of the black pillar boxes, choose Scale To Fill in the Source Scaling drop down menu in

the Output tab above the preview image.
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The pillar boxes will not show when
played on a DVD player connected to
a TV, but may show when the DVD is
played on a PC or Mac. Older versions
of Premiere used to stretch the image
horizontally to fit. If you absolutely
want the image to fit perfectly like it
used to, and destroy your aspect ratio,
you can. Just choose Stretch To Fill
instead of Scale To Fill.

Choose MPEG-2 for DVD as your format. Meta-
data like Chapter Markers are stored in an XMP
XML sidecar file.




In Encore CS6

Import Audio and Video as a
Timeline, and the frame rate
and frame size are automati-
cally set.

If the chapter Poster Frame
doesn't suit you, change it.

| generally choose PCM Audio, but you can also export Dolby Digital. Set Multiplexer to
None. Now export. This results in three files; m2v video, wav audio and an XMP file. The
XMP file has the markers, so do not delete it!

Open Encore, create a new DVD
project, and choose the proper
r New pra—— aimereameg | S€LTINGS for your country, PAL or
Nﬂ:ﬁm & Misking tar.mav NTSC. If you think you know more
i L Vaking s about MPEG settings for DVD
than the Adobe team, go ahead
and change the default transcode

settings. If not, leave them alone.
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Import the exported m2v and wav
files into Encore as a Timeline, and
your chapter markers will import
too. File > Import As > Timeline.
Make sure you choose both the
m2v and the wav file before you
hit Open.
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..... 00:01:21:23 Now you have a timeline with the same name as
; ; your Premiere Pro sequence had. The video and
Add Chapter Point . .

Delete Chapter Point audio are in sync and your chapter markers are

' Set Poster Frame there too.
Add Chapter Points at Intervals...

Making tar.wav

To save time when it's time to build the DVD,
right-click the wav file in the Project panel, and
choose Transcode Now.

Show Chapter Names

Preview from Here

If you don't like the Poster Frames for the chapters, adjust them by scrubbing to the frame
you want as the new poster frame, right-click the chapter point marker, and choose Set
Poster Frame.

If the language of your Audio is not English, change it in the drop-down menu in the Audio
timeline header.

If you want to create a looping DVD, just go to the Properties panel while your timeline is
active, and set End Action to Return to Here. Then build and burn.

If you want a more complex DVD, repeat the above procedure for every sequence that you
want as a separate choice on your DVD: Export, import as Timeline, change poster frames
and language if necessary.

Export



Make a DVD Menu

A Menu in Encore is in fact
a Photoshop PSD file and
can easily be tweaked in
Photoshop.

But most likely, you need a menu. If you've installed the Encore CS6 Library Content (see
http://helpx.adobe.com/encore/using/download-library-content.html for details) you
can create menus from templates. Since Encore Menus are PSD files, you may want to
create your own from scratch in Photoshop.

To create one from scratch in Encore; hit File > New > Menu to get a blank menu. Make
sure you set it to 16x9 in the Properties panel. Since we created this after the timeline, we
also need to set the new menu (which you should also rename to Main menu) as the First
Play. This is done by right-clicking the menu in the Project panel, and choosing Set as First
Play. The little Play icon on the timeline icon tells you that this was successful.

— - = You need a button, so use the Text Tool to write the text
Pknd @O T & you want to appear in the button. | wrote Play Movie. I'm so

: ol creative! Right-click the text and choose Convert to Button,
3 then switch to the Direct Selection Tool.

o Y. | suggest you do the rest of the design in Photoshop, so

© Effects right-click the menu, and choose Edit Menu in Photoshop. Add
R a background image, which could be an exported still frame

from Premiere, logos, texts and other graphics you need. Then

Save, and switch back to Premiere and watch the menu update

in Encore. Nice.
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T  Play Movie fx l

3 Effects

% Drop Shadow

B - Make sure you don't put anything in the Button layer group in
s Making Tar Menu 8 Photoshop. That's the one which name starts with (+) — which
is Encore-menu-language for Button.

With the Direct Selection Tool active, click the button in the menu and go to the Properties
panel. Click the little swirly icon on the Link, and hold down the mouse button while you
drag to the Timeline and let go. This is a very cool way to link your buttons.

If you don't like the Pick Whip - yes, that's the official name - you can also use the drop-
down menu and choose Main Menu > Play Movie (presuming your menu is named Main
menu, and the button is named Play Movie).

Set your End Action

Name the DVD

The Cool Stuff in Premiere Pro

When a user clicks the Play Movie button the timeline will play, but then what? We decide
what happens next by setting the End Action for the timeline. With the timeline active,
go to the Properties panel and use the Pick Whip next to End Action to point to the Main
menu in the Project panel.

This tells the DVD player to go to the Main menu when it has played the timeline.

Click in an empty area in the Project panel and go to the Properties panel. You'll see that
our DVD is named Untitled Project. What a bad name for a DVD! Change it to something
more meaningful.
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Importing a subtitle script
is the easiest way to create
the subtitles. It's much
easier to write the textina
word processor software
thanin Encore.

D@l 9 el aEeal@mw w
1 1 00:00:44:17 00:00:47:15 I'm going To a Town ~
that has already been burnt down

2
4 2 00:00:47:17 00:00:52:16 The flame over the smelting plant
s has died. I've got other towns and people in mind.

[

3 00:00:52:18 00:00:57:19 I'm going back to the town where I
went to school - all the way through primary and secondary.

@

s 4 00:00:57:21 00:01:06:13 Marit Eikemo ("samtidsruinar™)
10 I'm going to a class reunion and I'm singing:

11 "I've got a life to Tlead..."

1z 5 00:01:06:15 00:01:08:15 And when I'm in Hardanger
14 it strikes me:

Leading: |Top-fo-Top Leading .
16 6 00:01:08:17 00:01:12:24 "oh Hardanger, I'm so tired
17 of this trip.”

Subtitle Se
13 7 00:01:13:01 00:01:18:15 wainwright sings about Dublin.
20 "Going to a Town" was composed in five minutes-

en - English

2z 8 00:01:18:17 00:01:22:06 -when he was about to move from

2z New York to publin, Ireland's capital.

24 w
Ln23:1476 Col39 Sel0 69,2 kB ANS| CR+LF INS Default Text

You can import a subtitle script, or create subtitles in Encore, one by one. | always use a
script. You can write this in Word or any other word processor, and save as a txt file. See
the syntax in the image above. It's very simple, with In and Out time codes and manual line
breaks.

In Notepad or another simple text editor, make sure it's UTF-8 or UTF-16 encoded. If not,
change it and save again. Then import it to Encore. Timeline > Import Subtitles > Text
Script.

If the language is wrong, correct it in this dialog. You can also make changes to font, font
size etc. here. After the subtitles have been imported, they show up as a subtitle track in
the timeline. You can add more languages if you have them. You can change the In and
Out points of each individual subtitle if you want to.
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Flowchart

The Flowchart panel will show you a visual
view of the DVD behavior. Maximize the
panel to get a nice overview of your DVD. In

T . R S my example, you can see that the DVD title

The node-based Flow-
chart View is a very fast
way to check the project.

is Making Tar, that the First Play is the Main
menu, that the Play Movie button will take
you to the Making Tar timeline, and that the End Action of the timeline is to go back to the
Main menu. So everything looks good here. This is a good time to save the project.

Export




If you spot any errors you can use drag-n-drop to move links and timelines around. Any
timelines or menus you've forgotten to link to will show at the bottom of the flowchart
view as orphans. You can add them to the DVD by dragging them up into the main area in
the panel. | love the Flowchart view!

Preview the DVD

The built-in DVD Player
simulator is a nice way to
check if everything woks.

‘The image quality isn't stel-
lar, but you can at least see
if the links work.

Content you add here can
only be accessed on a PC

or Mac. Point Encore to the
folder that contains the files
you want to add.
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MAKING TAR

a short film by Jarle Leirpoll

- Output: | DVD

e Using: | Current Project

w Destination

Bi

Play Movie

File > Preview gives
you a nice little DVD
player preview, with
buttons you can
press, like on a remote
control. If everything
works OK here, you
should be ready to
build a DVD.

You can put content on your
DVD or Blu-ray disc that will
not be visible to your DVD
or Blu-ray player, but still is
available to PCs and Macs.

Even though this is not an
option under Blu-ray, the
folder you specify under DVD-
ROM Content will also be put
on a Blu-ray Disc.

In the Build panel, point to the
folder where you've gathered
your DVD-ROM assets.




Build a DVD Folder

This is what a Video-DVD
folder looks like. It contains
Video Objects, Info files and
Back-ups of the Info files.

Before you start the building process,
click the Check Project button and then
click Start. Any problems with the

DVD will be reported, and need to be
addressed before you can build a proper
DVD.

Although you can build a DVD disc
straight out of Encore, | do not
recommend it. If you're going to make
several copies, the process will be
repeated every time, and that’s a waste of time. So build a DVD Folder or Image instead.
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When the project has no problems to fix, click the Build button when DVD Folder is chosen
in the Output drop-down menu, and your DVD folder will be created. The result is a VIDEO_
TS folder, and if you've added DVD-ROM content, a few files outside of that folder.

This folder can be played back in VLC Player and other players, to see if everything works
OK if you want a final check.

Save DVD Image and burn DVD

You can burn the folder you created in the previous step onto a DVD, and it will be a fully
compatible Video-DVD. Some very, very old DVD players may even require an AUDIO_TS
folder - although it can be empty. Create one if you wish.

You can also create a DVD Image that you can burn to a DVD later. This creates on single
file, which helps to keep you organized. The process is the same as for a DVD Folder - just
choose DVD Image in the Output drop-down menu before you click on Build.

Now you can burn the image to disc. You'll need a DVD or Blu-ray burner and writeable
discs of course. | recommend that you don't burn directly from Encore, even though you
could. There is better burning software out there for free.

No Guarantees for Playback

There is no way you can guarantee that a home burnt disk will play in all DVD players.
There are different types of writeable DVDs; DVD+R, DVD-R, single sided, double-sided,
dual layer, single layer and re-writeable discs. Some DVD players can play most of these,
while other players can only play some of them. And some can play a particular brand of
one type, but not another brand with the same specs.

You can increase your chances of success if you buy good discs and make sure you have
the latest firmware for your burner. But the only way to make sure a DVD plays on all
players is to make a Glass Master, and mold the DVDs from that. Very few companies do
this now, but there should be at least one on each continent.

Export



If the DVD is destined
to be sent to a replica-
tion facility, | recom-
mend that you create a
DDP Image.

This is the content of a
DDP Image folder.

Dual Layer DVDs

Encore Video Tut

The Cool Stuff in Premiere Pro

The DVD Replication Facility will need a
< DDP Image » Making Tar v & | [ SokiMa. o DDP Image or a DLT Tape to create the
glass master from. I've always used DDP
image. This has the advantage of being
file based, so you can just transfer files
CONTROLDAT ooPD MAIN.DAT online to the facility. DLT tape requires a
DLT Tape Drive and snail mail shipping.
A DDP Image export result in a folder
with a three files; CONTROL.DAT, DDPID
and MAIN.DAT.

3 elementer  Filene er oppdatert — sist oppdatert for 2 timer siden

A dual layer DDP image would have two folders named Layer1 and Layer2, and just a
DDPID and MAIN.DAT in the Layer2 folder, while the Layer1 folder also has a CONTROL.DAT
file.

When you build a dual layer disk, Encore will ask you where you want to set the layer break,
but some problems have been reported.

Some replication facilities are picky about the DDP layer breaks, and you should make
absolutely sure that your DDP image is approved. If not, you can use the GEAR PRO
Mastering Edition software to move the layer break. They have a trial version that'’s fully
functional for a few days. An alternative is what's called “The Swiss Army knife of DVD
editing”, PgcEdit.

orials

Encore is a very good DVD authoring program, and it has capabilities far beyond what
normal users will ever need. There are lots of features and techniques we haven’t covered
here, like playlists, slide shows, pop-up menus, menu transitions, multiple languages,
audio and subtitle set-up menus, buttons, sub pictures, button routing, region codes
copy protection, bit budgeting, etc. Combine these with all the things you can create in
Photoshop, After Effects and Premiere, and the possibilities are endless.

| plan to make a series of tutorials for building beautiful and complex Blu-rays and DVDs in
Encore, so look out for this on http://premierepro.net.
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\ (e DVD projects can get pretty big and complex. Still,
@ setting up the links, menus, subtitle settings, language
choices and timelines is actually easy in Encore.






